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CREATE A FLYER – MS PUBLISHER 

All publications begin with a template, even if it’s a blank template. The trick is to find a template that looks 
like the vision you have for your final publication. Publisher comes with built-in templates. 
 

 : FILE, NEW, BLANK document 

 

 

 

 

 

  : enter text in the SEARCH BAR, click the SEARCH ICON 

 

 

 

 

 

 

 

  – click the BUILT-IN LINK, choose a CATEGORY, make a selection 

 

 

 

 

 

 

Edit/Add a Text Box 

Most templates contain text boxes you can fill in, but you can also add your own text boxes. 
 

 :  

o Text - Click in text box, type; use CTRL+A to select all text 

o Text Box Style - select a text box, click FORMAT TAB from Ribbon 

 : 

o INSERT, DRAW TEXT BOX, hold left mouse button and draw box 
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Text Overflow 

When a text box contains more text than it can display, a little box with ellipses appears in the lower right of 
the text box and Publisher stores the extra text in overflow. You can move your text out of overflow and back 
into your publication by moving text into another text box, fitting text automatically, enlarging the text box, 
changing the text size, changing the margins within the text box, or deleting some of the text in the text box.  
 

Link Text Boxes 

 Create a new text box. 

 Click the OVERFLOW INDICATOR and your cursor becomes a PITCHER.   

 Move to the new text box and click. The overflow text will show up in the new text box. 

 Now as you add text, words flow from one text box to another.  

 

 

 

 

 

 

Master Page 

Master pages contain the elements that you want to repeat on multiple pages in a publication.  
 

 

 

 

 

 

 

 

 

 

 

 

 On the VIEW menu, click MASTER PAGE A.  

 In the EDIT MASTER PAGES task pane, point to the name of the master page that you want to edit, click 

the arrow, and then click EDIT. 

 Any EDITS/ADDITIONS to the MASTER PAGE appear on every page, unless another Master Page is used. 

Choose NONE to discontinue using a Master Page. 
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CREATE A FLYER – ADOBE INDESIGN 

 

 Select Create New Document. Set the number of pages to 1. The default page size is Letter; click the 

dropdown to switch the size. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Edit/Add a Text Box 

If the insertion point is not inside a text frame when you paste text into InDesign, a new plain text frame will 
be created. If the insertion point is inside a text frame, the text will be pasted inside that frame.  
 

 :  

o Paste – Copy text, CTRL+V to paste (new textbox created) 

o Paste Options – EDIT, PREFERENCES, CLIPBOARD HANDLING (choose ALL INFORMATION to 

keep formatting) 

 

 : 

o Use the TYPE TOOL, , to drag and create a new text frame 

o Using the Select tool, , to make changes to the text frame 
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Text Overflow 

A red plus sign (+) in an out port indicates that there is more text in the story. To flow text between connected 
frames (also called text boxes), you must first connect the frames. Connected frames can be on the same 
page, or on another page in the document. The process of connecting text among frames is called threading 
text. 
 

Link Text Boxes 

Each text frame contains an in port and an out port, which are used to make connections to other text frames. 
An empty in port or out port indicates the beginning or end of a story, respectively. An arrow in a port 
indicates that the frame is linked to another frame. A red plus sign (+) in an out port indicates that there is 
more text in the story to be placed but no more text frames in which to place it. This remaining unseen text is 
called overset text. 

 

 

 

 

 

 

 

 

 

A. In port at beginning of story B. Out port indicating thread to next frame 

C. Text thread D. In port indicating thread from previous frame E. Out port indicating overset text 

 

Choose View > Extras > Show Text Threads to see visual representatives of threaded frames. You can thread 
text frames whether or not they contain text. 
 

Graphics 

The Place command is the primary method used to insert graphics into InDesign because it provides the 
highest level of support for resolution, file formats, multipage PDF and INDD files, and color. To place graphics 
is also referred to as import images and insert pictures. 
 

 Do one of the following: 

o To import a graphic without first creating a frame, make sure that nothing in the document is 

selected. 

o To import a graphic into an existing frame, select the frame. If the new image is larger than the 

frame, you can refit the frame later by choosing OBJECT > FITTING > [FITTING COMMAND]. 

o To replace an existing image, select its graphics frame. 

o Choose FILE > PLACE and select one or more graphics files of any available format. 
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CREATE A TRI-FOLD BROCHURE – MS PUBLISHER 

 

1. On the Start page that appears when you open Publisher, click Brochure or type Brochure in the 

Search field and press Enter. 

2. Click a brochure in the gallery of brochure templates and click Create. 

 

 

Change the template 

 

1. Click Page Design > Change Template. 

2. Replace the template text or graphics by right-clicking a text box or graphic and clicking Delete Text or 

Change Picture. 

 

Customize a template 

 

1. Click the Page Design tab and experiment with color themes, font, and backgrounds. 

2. When you’re happy with the results, click File > Print and choose an option: 

o Click Export to find save as PDF or other Pack and Go options for photo or commercial 

printing. 

o Click Print to make copies on your personal printer. 
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CREATE A TRI-FOLD BROCHURE – ADOBE INDESIGN 

The trickiest part of creating a tri-fold brochure is setting up the layout. After that, you place content in the 

brochure as you would in any other InDesign document. 

 

 Click the FILE menu, choose NEW, and then select DOCUMENT. 

 Click the INTENT DROP-DOWN menu and choose PRINT. 

 Type 2 in the NUMBER OF PAGES field. 

 Click the FACING PAGES check box to turn off. 

 Click the PAGE SIZE DROP-DOWN menu and choose LETTER. 

 Click the LANDSCAPE button in the ORIENTATION area of the dialog box. 

 Type 3 in the NUMBER field in the COLUMNS section. 

 Type 2 in the GUTTER field. (Gutters are spaces between columns. In a tri-fold brochure, gutters are also 

where the brochure folds.) 

 Click OK. InDesign creates two three-column pages. Each column is a panel in your brochure - three 

outside panels and three inside panels. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

So that the brochure folds and opens properly, create the panels of a tri-fold brochure as follows: 

o Panel 1, the cover, goes in the third column of page 1.  

o Panel 2, the first inside panel, goes in the first column of page 2.  

o Panel 3 goes in the second column of page 2.  

o Panel 4 goes in the third column of page 2.  

o Panel 5 goes in the first column of page 1.  

o Panel 6 goes in the second column of page 1. 

This is the order in which the reader unfolds and reads the brochure. 
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Photoshop 
 

Resize and Resample  

RESIZING an image changes the print size (height and width) but not the pixel dimensions of the image. 

RESAMPLING an image changes the number of pixels in the image. When you increase the number of pixels in 

an image, the size of the file also increases. Conversely, removing pixels from an image decreases the size of 

the file. 

 Pixel Dimensions (resample) = web 

 Document Size (resize) = print 

 

1. Click FILE, OPEN, and, then, navigate to the DESKTOP and select Pumpkins.jpg from the PHOTOSHOP 

SAMPLE FILES folder. 

2. From the menu bar, select IMAGE, IMAGE SIZE. 

 

Resize – resolution changes as image size changes 

Resample – resolution stays the same: 

 Bicubic (best for smooth gradients) - Very precise 

method that calculates the averages of surrounding 

pixels. 

 Bicubic Smoother (best for enlargements) -  Based 

off of Bicubic sampling and works best when enlarging 

images that have high image noise. Images will look 

smoother or more soft with this method. 

 

 

Web images work differently than printed images. With printed images, we must pay close attention to 

resolution to ensure we get a high-quality print. For web images, we must focus on the pixel dimensions. Look 

at the two images below - one is 300ppi and the other is 72ppi. 

 

Both of these images display at the exact 

same size even though their resolution varies. 

This is because the pixel dimensions are what 

really matter when working with web images.  

 

 

Notice that the pixel dimensions of each image are the same and therefore both images will display at the 
same size even though they have differing resolutions.  
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Crop  

CROPPING is the process of removing portions of an image to create focus or strengthen the composition.  

1. Click FILE, OPEN, and, then, navigate to the DESKTOP and select Thistles.jpg from the PHOTOSHOP 

SAMPLE FILES folder. 

2. Select the CROP tool, .   

3. Drag the mouse over the part of the image you want to keep to create a marquee. 

 

 
4. If necessary, do one of the following to adjust the cropping marquee: 

o To move the marquee to another position, place the pointer inside the bounding box, hold 

down the left mouse button and drag. 

o To scale the marquee, drag a handle. To constrain the proportions, hold down the [SHIFT] key 

as you drag a corner handle. 

5. In the OPTIONS bar, set the following: 

o Cropped Area: Select HIDE to preserve the cropped area in the image file. You can make the 

hidden area visible by moving the image with the MOVE tool. Select DELETE to discard the 

cropped area. 

o Crop Guide Overlay: Select Rule Of Thirds to add guides that help you place compositional 

elements at 1/3 increments. Select GRID to display fixed guidelines with spacing that depends 

upon crop size. 

6. Then, do one of the following: 

o Press ENTER to complete the crop. 

 Alternatively, click the COMMIT button, , in the OPTIONS bar, or double-click inside 

the cropping marquee to complete the crop. 

o Press [ESC] or click the CANCEL button, ,  in the OPTIONS bar. 

7. Click FILE, CLOSE to finish working with the file and not save any changes. 
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Transform  

 

1. Click FILE, OPEN, and, then, navigate to the DESKTOP and select butterfly.jpg from the PHOTOSHOP 

SAMPLE FILES folder.  

 

NOTE: Free Transform affects the pixels inside the selection outline while Transform Selection 

affects only the selection outline itself. 

 

2. Using the RECTANGULAR MARQUEE TOOL,  , select an area that you want to transform.  

o Let some of the butterfly’s wings and antennae extend beyond the selection. Usually, people 

will undo and redo the selection. Instead of starting over, you can use Transform Selection. 

3. Choose EDIT, FREE TRANSFORM. (not the correct method, used for example) 

o The Free Transform command places transform handles (little squares) around the selection. 

You can alter the shape and size of the selection by clicking on any of the handles and dragging 

them. However, this will stretch the image. 

o Press the ESC key to exit Free Transform. 

4. Choose SELECT, TRANSFORM SELECTION. 

o The Transform Selection command also places the same handles around the selection, just like 

Free Transform did, but these handles affect the selection outline itself, not the pixels inside of 

it. 

 

5. You can move and rotate the selection outline as well using Transform Selection. To move it, simply 

click anywhere inside the selection outline and drag it around inside the document with your mouse. 

To rotate it, move the cursor outside the selection outline, then click and drag. 
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o Rotate the selection outline a few degrees counterclockwise. Then, press ENTER. 

 
6. Copy the selection to it’s own layer: LAYER, NEW, LAYER VIA COPY or CTRL+J. 

 
7. Click on the LAYER STYLES icon at the bottom of the Layer panel. 

 
8. Choose STROKE from the list of Layer Styles, to place a simple photo border around the selected area, 

giving a "picture in picture" effect. 

9. Set the options to: 

 
10. Add a shadow to the selected area as well by clicking directly on the words DROP SHADOW at the top 

of the list of layer styles along the left of the dialog box. 

 
11. Click OK. 
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12. Finally, convert the background to Black/White. 

o Click on the Background layer in the Layers panel to select it, then press CTRL+J to duplicate 

the layer. Photoshop gives many ways to convert images to black and white, including, at the 

bottom of the Layers panel, the Black And White image adjustment.  
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Remove an Object  

The CONTENT AWARE feature allows you to quickly fill in a selection with surrounding content making it look 

like a part of the original image. 

 

1. Select Beach.jpg from the PHOTOSHOP SAMPLE FILES folder. For this exercise, you will be removing 

the man on the left. 

2. Click VIEW, FIT SCREEN to enlarge the image. 

3. Using the PEN tool,  , make a path around the subject. 

o If the subject has many curved areas, it may be easier to use the FREEFORM PEN tool. Click the 

dropdown arrow in the lower right corner of the PEN tool for additional selection options. 

 
o Try to keep a close distance all the way around. If you go too close, CONTENT AWARE will take 

pixels from the subject. If you cut too far, it will take pixels from the woman on the right. 
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4. Once you complete the path around the subject, right click on the path and select MAKE SELECTION 

from the menu. 

 

                     
5. In the Make Selection dialog box, set FEATHER RADIUS to 0 pixels. 

6. Click OK to turn the path into an active selection. 

7. Click EDIT, FILL and then do the following: 

o Set the Contents Use to CONTENT AWARE. 

o Set the Blending Mode to NORMAL and the Blending Opacity to 100%. 

o Click OK. 

8. Click SELECT, DESELECT to remove the active selection. 

9. If the Content Aware tool did not completely remove the selection or if it replicated pixels from the 

woman in the picture, do the following: 

o Use the RECTANGULAR selection tool,  , to draw a rectangle around the area. 

o Click EDIT, FILL, OK. 

o Click SELECT, DESELECT to remove the active selection. 
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Replace the Color of Objects  

 

1. Click FILE, OPEN, and, then, navigate to the DESKTOP and select car.jpg from the PHOTOSHOP SAMPLE 

FILES folder. 

2. Choose IMAGE, ADJUSTMENTS, REPLACE COLOR. 

3. Use the EYEDROPPER tool, ,  to select in the main image a yellow color in the middle of the car’s 

hood.  

o Use the ADD TO SAMPLE Eyedropper tool, ,   to add additional areas.  

o Use the SUBTRACT FROM SAMPLE Eyedropper tool, ,  to remove areas. 

 

 
4. Use the FUZZINESS slider to adjust the color area. The area in white will be replaced. 

5. Double-click the RESULT color swatch in the Replacement section and use the COLOR PICKER to select 

the replacement color. 

 

 
6. Drag the HUE, SATURATION, and LIGHTNESS sliders or enter values in the text boxes to fine tune the 

resulting color. 

7. Click OK. 
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Magnetic Lasso Tool 

The MAGNETIC LASSO TOOL detects and snaps to the edge of an object as you trace along its outline. In this 

exercise, you will use the Magnetic Lasso tool to select a portion of an image and save that portion as a file 

with a transparent background. 

 

1. Click FILE, OPEN, and, then, navigate to the DESKTOP and select leaf.jpg from the PHOTOSHOP 

SAMPLE FILES folder. 

2.  Click and hold the left mouse button down on the LASSO TOOL until a fly-out menu appears and, then, 

select the MAGNETIC LASSO TOOL from the list. 

o The magnet icon, , indicates the Magnetic Lasso Tool selection. 

 

 
o Optionally, press the [CAPS LOCK] key on your keyboard. This switches the icon to a circle with 

a small crosshair in the center, . The circle represents the width of the area that Photoshop 

looks for in edges. Only the area inside the circle is looked at while everything outside of it is 

ignored. 

3. If necessary, change the following in the Options Bar: 

o Width - If the object has a well-defined edge, use a larger width setting, which will also allow 

you to move faster and more freely around the object.  

o Edge Contrast –Determines how much of a difference there must be in color or brightness 

value between the object and its background. For areas with high contrast, use a higher Edge 

Contrast value with a larger Width value.  

o Frequency - Photoshop automatically places anchor points along the edge to fasten the line in 

place. If there's too much of a gap between anchor points, making it difficult to keep the line 

clinging to the edge, adjust how often Photoshop adds anchor points; the higher the value, the 

more anchor points will be added. Generally, the default value of 57 works well.  

 

 
 

4. Place the crosshair in the center of the circle directly over an edge of the leaf and click the left mouse 

button once. Then, release the mouse button. 

o This sets the starting point for the selection. 

5. Move the Magnetic Lasso Tool around the object, always keeping the edge within the boundaries of 

the circle.  
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o The tool will drop fastening points to anchor the selection. 

o If an anchor point gets added in the wrong spot, press the [BACKSPACE] key to remove the last 

anchor point that was added. Continue pressing the [BACKSPACE] key to remove additional 

points in the reverse order they were added. 

 

 
 

6. Click on the initial starting point to complete the selection. A small circle appear in the bottom right of 

the cursor icon, , indicating that the mouse button can now be clicked to close the selection. 

 

 
 

7. To remove the background, click SELECT, INVERSE. Then, click EDIT, CUT.  

 

 
 

8. To save the image with a transparent background, click FILE, SAVE AS and select the .GIF format. Then, 

click SAVE.  

9. In the Indexed Color dialog box, make sure TRANSPARENCY is checked. Then, click OK twice.  

o Note: .JPG’s do not support transparent backgrounds; only .GIF’s and .PNG’s. 
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Selecting with the Quick Selection Tool 

You can use the QUICK SELECTION TOOL to quickly “paint” a selection using an adjustable round brush tip. As 

you drag, the selection expands outward and automatically finds and follows defined edges in the image. In 

this exercise, the background will be colorized with a single color. 

 

1. Click FILE, OPEN, and, then, navigate to the DESKTOP and select wheelbarrow.jpg from the 

PHOTOSHOP SAMPLE FILES folder. 

2. Select the QUICK SELECTION TOOL, . 

3. Move the Quick Selection cursor to the top left corner of the child's sweater 

and click once with the mouse. An initial selection outline appears around the 

area.  

4. Click and drag over the area you need to select as if you were painting with a 

brush. 

o The Quick Selection tool is in “Add to selection” mode by default.  

 
5. If the background gets added to the selection, press [CTRL]+Z to undo the selection. 

o If the selection cursor size is too large, decrease the pixel size, , in the OPTION bar.  

6. To remove the gap between the sweater and the child's arm where the background is showing 

through, do one of the following: 

o Hold down the [ALT] key which temporarily switches the Quick Selection tool to “Subtract from 

selection” mode.  

o Select the "Subtract from selection" option, , in the Options bar. Note: Remember to switch 

back to the "Add to selection" mode when you're done.  

7. While in “Subtract from selection” mode, click and drag inside the area you need to remove. 

                   
8. After selecting the child and wheelbarrow, click SELECT, INVERSE to make the background the main 

selection. 
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9. Click the NEW ADJUSTMENT LAYER icon, , at the bottom of the Layers panel and choose 

HUE/SATURATION. Then, check the COLORIZE option and drag the HUE slider towards the right to 

select a brown color similar to the color of the wheelbarrow. 

 
 

10. Click OK to exit from the Hue/Saturation dialog box. 

11. Change the blend mode of the adjustment layer to COLOR so that only the colors in the image, not the 

brightness values, are changed. 

 

 
12. Your result should look similar to the image below: 
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Selecting with the Magic Wand tool 

The Magic Wand tool lets you select a consistently colored area, such as a background, without having to trace 

its outline. 

 

1. Click FILE, OPEN, and, then, navigate to the DESKTOP and select peppers.jpg from the PHOTOSHOP 

SAMPLE FILES folder. 

2. Select the MAGIC WAND TOOL. 

 

 
 

3. In the OPTIONS bar, specify any of the following, if necessary: 

o Tolerance - The Tolerance option tells Photoshop how different in tone and color a pixel can be 

from the selected area we clicked on for it to be included in the selection. By default, the 

Tolerance value is set to 32, which means that Photoshop will select any pixels that are the 

same color as the area clicked on, plus any pixels that are up to 32 shades darker or 32 shades 

brighter.  

o Anti-aliased – This option creates a smoother-edged selection.  

o Contiguous – This option selects only adjacent areas using the same colors. Otherwise, all pixels 

in the entire image using the same colors are selected. 

o Sample All Layers - The Magic Wand tool selects colors from the active layer only unless this 

option is selected.  

4. In the image, click the brown color in the background. Notice that not all of the background has been 

selected. 

 

5. Do one of the following to include all the background: 

o Set the Tolerance option to a value greater than 35. 

o Change the Magic Wand tool to “Add to selection” mode in the 

Options bar and click somewhere in the background that wasn’t 

selected. 

6. For this exercise, choose “Add to selection” mode, and, then, click 

an unselected area of the background. 
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7. Rather than removing the background and saving as a transparent background, replace it with another 

image. To select the peppers underneath the background, click SELECT, INVERSE. 

o Then click LAYER, NEW, LAYER via COPY. 

 

 
 

8. Click FILE, OPEN, and, then, navigate to the DESKTOP and select sky.jpg from the PHOTOSHOP 

SAMPLE FILES folder. 

9. Press [CTRL]+A to select the entire image of the sky and, then, press [CTRL]+C to copy the image to the 

clipboard. 

10. Switch back to peppers.jpg and click on the Background layer in the Layers panel. 

11. Press [CTRL]+V to paste the sky, it should look similar to the one below: 

 

 
 

Filters 

The FILTER GALLERY provides a preview of many of the special effects filters. You can apply multiple filters, 

turn on or off the effect of a filter, reset options for a filter, and change the order in which filters are applied. 

When you are satisfied with the preview, you can then apply it to your image.  

 

1. Click FILE, OPEN, and, then, navigate to the DESKTOP and select girl-sitting.jpg from the PHOTOSHOP 

SAMPLE FILES folder. 

2. Right-click on the Background layer and choose DUPLICATE LAYER. Name this layer Filters. 

o The filtered effects will be applied to Filters, the duplicate layer. The Background layer will not 

change so you can revert back to the original image at any time. 
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3. Click FILTER, FILTER GALLERY. 

o The large preview window displays each effect applied to the image in real time. You can apply 

multiple filters, adjust each filter independently, change the filter order and even run the same 

filter twice.  

 

 
4. Select a filter from the gallery and click the SHOW/HIDE box next to the filter’s name to apply the 

effect to the photo. The filter’s effect is visible when an eye is displayed in the box, . 

o For this exercise, select PAINT DAUBS from the ARTISTIC folder. 

o Click the SHOW/HIDE box to apply the Paint Daubs effect. 

5. To add a new filter, click the NEW EFFECT LAYER icon, , at the bottom of the palette.  

o To delete a filter, click the Delete Effect Layer, , icon. 

6. The new effect layer will be a duplicate of the previous layer. Click this layer to select it and, then, 

choose a new filter. 

o For this exercise, select ANGLED STROKES from the BRUSH STROKES folder.  

7. For a different effect, drag ANGLED STROKES below PAINT DAUB. 

8. Click OK to exit from the Filter Gallery. Your photo should look similar to the one below: 
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Creating Type On A Path In Photoshop 

 

To add type to a path, we first need a path, and Photoshop gives us a few different ways to draw one. We can 

use the standard Shape Tools like the Rectangle Tool or the Ellipse Tool, we can create a path from custom 

shapes, and we can draw a freeform path using the Pen Tool.  

To keep things simple for this tutorial, we'll stick with Photoshop's basic Shape Tools. 

 

Select The Ellipse Tool 

1. Select the Ellipse Tool from the Tools panel. By default, it's hiding behind the Rectangle Tool, so click 

on the Rectangle Tool and hold your mouse button down for a second or two until a fly-out menu 

appears, then select the Ellipse Tool from the list: 

 
Select The "Paths" Option 

2. With the Ellipse Tool selected, the Options Bar along the top of the screen changes to show us various 

options for working with the tool. Near the far left of the Options Bar is a series of three icons, each 

one representing a different type of shape we can draw in Photoshop. We can draw vector-based 

shapes, paths, or pixel-based shapes. Click on the middle of the three icons to choose the Paths option: 

 
Draw Your Path 

3. With the Ellipse Tool selected and Paths chosen in the Options Bar, click inside your document and 

drag out an elliptical path. Holding your Shift key down as you drag will force the path into a perfect 

circle. To draw the path out from its center rather than from a corner, hold down your Alt key as you 

drag. If you need to reposition the path as you're drawing it, hold down your Spacebar, drag the path 

to a new location, then release your spacebar and continue dragging. 

4. In this example, draw a circular path around the golf ball. The path appears as a thin outline: 
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Select The Type Tool 

5. With the path drawn, add text. Select the Type Tool from the Tools panel: 

 
Choose Your Font 

6. With the Type Tool selected, choose your font settings from the Options Bar. In this example, use 

Futura Condensed Medium set to 13 pt. and set the text color to white: 

 
Move The Cursor Over The Path 

7. Move the Type Tool directly over the path. The cursor icon will change to an I-beam with a dotted 

wavy linethrough it. This tells us we're about to add text directly to the path itself: 

 
Click On The Path And Add Your Type 

8. Click anywhere along the path and begin adding your text. The spot you click on is where the text will 

begin, but don't worry if you've clicked on the wrong spot because you can easily move the text around 

on the path once you’ve added it, as you’ll see in a moment. As you type, the text follows the direction 

of the path: 

 
9. Continue adding your text along the path. When you're done, click on the checkmark in the Options 

Bar to accept it and exit out of Photoshop's text editing mode: 
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10. The text is now added to the path, although at the moment it's on a bit of a weird angle: 

 
Select The Path Selection Tool 

11. To reposition your text along the path, choose the Path Selection Tool from the Tools panel: 

 
12. Move the Path Selection Tool's cursor anywhere over top of your text. You'll see the cursor change 

from a black arrow into an I-beam with a small arrow on the side of it pointing left or right. Simply 

click on your text and drag it back and forth along the path with your mouse. Here, the text is being 

dragged clockwise around the circle: 

 
13. Watch what happens, though, if the text is dragged too far. Some of it gets cut off at the end: 
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14. The end was cut off because the text was moved beyond the visible text area on the path. To fix the 

problem, look for a small circle on the path at the spot where the text is being cut off. The circle marks 

the end of the visible area: 

 
15. Simply click on the circle with the Path Selection Tool and drag it further down the path until all of your 

text is visible once again. Here, as the circle is dragged clockwise along the path, the text that was cut 

off reappears: 

 
 

Flipping The Text Over The Path 

16. Be careful as you're dragging your text along the path that you don't accidentally drag across the path. 

If you do, the text will flip to the other side and reverse direction: 

 
17. Depending on the effect you're going for, flipping and reversing the text like this may be what you 

wanted to do, but if you didn't do it on purpose, simply drag back across the path with the Path 

Selection Tool and your text will flip back over to the original side. It will also revert back to its original 

direction. 
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Hiding The Path 
1. When you're done positioning your text and you're happy with the results, hide the path by pressing 

CTRL + H. 
2. With the path now hidden and the text flipped back over to its original side, here's the final result: 
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Clipping Mask 

Clipping masks use the contents and transparency of a layer to determine which parts of the layer above it 

remain visible. Creating a clipping mask works well when your image needs to fit within a clearly-defined 

shape. 

 

1. Open the oval picture frame image (works best with a black interior background). 

2. Open the dog grooming image. 

 Take a look at the pixel size of the picture frame; compare to the size of the dog grooming 

image. Change the pixel size of the dog to be closer in size to the picture frame. 

3. Move the dog grooming image to a new layer in the oval picture frame document. 

 

 
 

4. Hide the top layer by clicking its visibility icon, and then click on the Background layer to select it. 

 

 
 

  



30 

 

 

 

5. Select the area inside the frame; since it’s filled with solid black, select it using the Magic Wand. 

 

   
 

6. Copy the selected area to a new layer by going to the Layer menu, choosing New, and then 

choosing Layer via Copy. 

7. To create the clipping mask, select the top layer, and turn the layer back on by clicking its visibility icon. 

Choose Create Clipping Mask from the Layer menu. The image is now clipped to "Layer 1" below it. 

8. With the clipping mask created, the photo now appears only inside the frame, since that's the only part 

of the image that's sitting above actual content on the layer below it. The rest of the photo is hidden 

because it's sitting above transparency. 

 

 
 

9. Finally, move the content around inside the clipping mask using the Move tool. You can also resize 

content within a clipping mask just as easily using Free Transform.   

 The Free Transform handles appear around the entire image, including the hidden areas. To 

resize it, press and hold the Shift key as you click on the corner handles and drag them. Holding 

the Shift key locks the aspect ratio of the image so you don't distort it. To accept, press Enter. 

 

 
 


